
 
 
 
 

VDR-100G3/G3S Data Recovery 
User Manual 

 
RUT-UM-02-003 Rev. 1.1  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rutter Technologies Inc. 
70 Brookfield Road 

St. John’s, NL Canada 
A1E 3T9 

 
Tel: (709) 368-4213 

Fax: (709) 368-1337 
 

www.ruttertech.com 
 



This page is intentionally blank. 



Rutter Technologies Inc. 
VDR-100G3/G3S Data Recovery 
User Manual 
 
RUT-UM-02-003 Rev. 1.1 
 
Revision Issue Date: June 10, 2008 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Rutter Technologies’ Worldwide Service List is available for download in PDF format at 
the following web site address: http://www.ruttertech.com/support/ 
 
 
© Copyright Rutter Technologies Inc 
 
All rights reserved. This document contains CONFIDENTIAL information that is PROPRIETARY to Rutter Technologies 
Incorporated. This commercially sensitive information is being provided to the recipient solely for the purpose specified 
and shall not be reproduced, disclosed or supplied, in whole or in part, to any other person without the prior written 
consent of Rutter Technologies Inc. 
 
Although every precaution has been taken in the preparation of this manual, Rutter Technologies Inc assumes no 
responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of information 
contained herein. 



This page is intentionally blank. 



VDR-100G3/G3S Operation and User’s Manual   10/06/2008 
RUT-UM-10-002 Rev. 1.0 
 

Amendment Record 
 
The details of any amendment made to this documentation should be recorded in the table below. 
These details should include the signature of the person responsible for inserting the latest 
amendment. 
 

Description Date Inserted Initials/Sig. 

Release Version 1.1 June 10  

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   



VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

This page is intentionally blank.



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

I

Rutter VDR—100G3/G3S Data Recovery Manual 
Table of Contents 

1 INTRODUCTION TO DATA RECOVERY FOR THE RUTTER VDR-100G3/G3S................... 1 
2 CLIENT PC DOWNLOAD—DATA RETRIEVAL METHOD NUMBER 1................................. 3 

2.1 MINIMUM CLIENT PC REQUIREMENTS ............................................................................................ 3 
2.2 INSTALLATION OF DOWNLOAD SOFTWARE ON CLIENT PC.............................................................. 4 
2.3 CONNECTING TO THE VDR.............................................................................................................. 5 
2.4 STARTING THE DOWNLOAD PROCESS.............................................................................................. 5 

2.4.1 Download The Current Data Set ............................................................................................ 6 
2.4.2 Download A Secured Data Set................................................................................................ 7 
2.4.3 Download An Archived Data Set ............................................................................................ 9 
2.4.4 Download All Current, Secured And Archived Data Sets..................................................... 10 
2.4.5 Get Current Data Set Contents............................................................................................. 11 
2.4.6 Error Log and Battery Log ................................................................................................... 11 

2.5 COMPLETE VS. PARTIAL DOWNLOAD ............................................................................................ 11 
2.6 DISCONNECTING FROM THE VDR.................................................................................................. 11 

3 USB MEMORY STICK (OR OPTIONAL RSM)—DATA RETRIEVAL METHOD NUMBER 2
 13 

3.1 COPYING DATA TO A USB MEMORY STICK (OR OPTIONAL RSM)................................................. 13 
3.2 CONNECTING THE USB MEMORY STICK ....................................................................................... 14 
3.3 CONNECTING THE RSM................................................................................................................. 15 
3.4 DISCONNECTING THE USB MEMORY STICK OR RSM.................................................................... 15 
3.5 RE-CONNECTING THE USB MEMORY STICK OR RSM ................................................................... 16 
3.6 CONNECTING THE CLIENT PC TO THE USB MEMORY STICK......................................................... 18 
3.7 CONNECTING CLIENT PC TO RSM ................................................................................................ 18 

4 FRM/SFRM DOWNLOAD—DATA RETRIEVAL METHOD NUMBER 3............................... 19 
4.1 DAMAGE TO SHIP AND MINOR DAMAGE TO FRM/SFRM ............................................................. 19 

4.1.1 Downloading FRM/SFRM Data Directly to the VDR-100G3 .............................................. 19 
4.1.2 Downloading FRM/SFRM Data Direct to Playback/Client PC ........................................... 26 

4.2 NO VDR COMMUNICATIONS WITH FRM/SFRM........................................................................... 27 
4.2.1 Connecting to Rutter FRM (RUT-02447) or L3 HVR/SVR Fixed FRM/SFRM Capsules..... 27 
4.2.2 Connecting to a Rutter-ACR Float-Free SFRM Capsule ..................................................... 28 
4.2.3 Connecting to a Jotron Float-Free SFRM Capsule.............................................................. 28 
4.2.4 Installing the FRM Download Application........................................................................... 28 
4.2.5 Copy VDRPARAMS.INI........................................................................................................ 31 
4.2.6 Setting the Client PC IP Address.......................................................................................... 31 
4.2.7 Downloading Data Using the FRM Download Application ................................................. 32 

4.3 DAMAGE TO SHIP AND SEVERE DAMAGE TO FRM/SFRM ............................................................ 35 
5 OPERATION AND ALARM UNIT—USER GUIDE..................................................................... 37 

5.1 OAU DISPLAY............................................................................................................................... 37 
5.2 OAU KEYPAD ............................................................................................................................... 37 
5.3 SECURING DATA ........................................................................................................................... 38 
5.4 MUTING AUDIBLE ALARM ............................................................................................................ 38 
5.5 DIMMING THE DISPLAY ................................................................................................................. 38 
5.6 TEST SCREEN ................................................................................................................................ 38 
5.7 VIEWING RECORDED DATA ON THE DMM INTERNAL HARD DRIVE ............................................. 39 
5.8 STATUS AND ALARM MESSAGES................................................................................................... 40 

6 PLAYBACK SOFTWARE................................................................................................................ 41 
6.1 PLAYBACK INSTALLATION – CLIENT/STANDALONE PC ................................................................ 41 



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

II

6.2 STARTING THE PLAYBACK APPLICATION ...................................................................................... 43 
6.2.1 Configuration File ................................................................................................................ 43 

6.3 CHOOSING DATA FOR PLAYBACK.................................................................................................. 44 
6.3.1 Unarchive Extracted Data.................................................................................................... 45 

6.4 ENABLING ETHERNET BROADCASTS ............................................................................................. 46 
6.5 STARTING THE PLAYBACK ............................................................................................................ 47 
6.6 CONFIGURING THE CLIENT TO RECEIVE REAL TIME DATA ........................................................... 47 
6.7 ENABLING REAL TIME DISPLAY MODE ......................................................................................... 48 
6.8 STARTING THE PLAYBACK IN REAL TIME DISPLAY MODE ............................................................ 49 
6.9 PASSWORDS .................................................................................................................................. 49 
6.10 PLAYBACK CONTROLS .................................................................................................................. 50 
6.11 AUDIO VOLUME & CHANNEL SELECTION ..................................................................................... 51 
6.12 CONNING PAGE TAB...................................................................................................................... 52 

6.12.1 Depth Graph......................................................................................................................... 53 
6.12.2 Wind Information.................................................................................................................. 53 

6.13 PROPULSION TAB .......................................................................................................................... 54 
6.14 VIDEO CHANNEL DISPLAY TAB(S) ................................................................................................ 54 
6.15 PROPRIETARY TAB ........................................................................................................................ 55 
6.16 AIS PLAYBACK TAB...................................................................................................................... 56 

6.16.1 Targets.................................................................................................................................. 56 
6.16.2 View Settings ........................................................................................................................ 57 
6.16.3 GuardZone............................................................................................................................ 58 

6.17 LOG TAB ....................................................................................................................................... 59 
6.17.1 Error Codes .......................................................................................................................... 60 

6.18 FIRE DOORS TAB........................................................................................................................... 61 
6.19 WATER DOORS TAB ...................................................................................................................... 62 
6.20 HULL OPENINGS TAB .................................................................................................................... 63 
6.21 ALARMS TAB ................................................................................................................................ 63 
6.22 DATA EXTRACTION ....................................................................................................................... 63 

6.22.1 Open Extraction Window...................................................................................................... 63 
6.22.2 Selecting Data for Extraction ............................................................................................... 64 

6.23 CLOSING THE PLAYBACK APPLICATION ........................................................................................ 65 
APPENDIX A – INCIDENT DATA RECOVERY CHECKLIST .....................................................- 67 - 
APPENDIX B – SOFTWARE DOWNLOAD (FTP)........................................................................... - 69 - 
APPENDIX C – CONTACT INFORMATION ...................................................................................- 71 - 
APPENDIX D – IMO GUIDELINE DOCUMENT.............................................................................- 85 - 

 
 



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

III

List of Figures 
 
Figure 2-1 - Establishing TCP/IP Address....................................................................................... 4 
Figure 2-2 - VDR Data Port ............................................................................................................. 5 
Figure 2-3 - Download Software Main Screen ................................................................................ 5 
Figure 2-4 - Download Controls Menu ............................................................................................ 6 
Figure 2-5 - Download Settings Window ......................................................................................... 6 
Figure 2-6 - Sample Download Directory ........................................................................................ 7 
Figure 2-7 - Download Secured Data Sets...................................................................................... 7 
Figure 2-8 - Partial Download Window............................................................................................ 8 
Figure 2-9 - Confirm Download Settings ......................................................................................... 8 
Figure 2-10 - Download Archived Data Sets ................................................................................... 9 
Figure 2-11 - Partial Download Window.......................................................................................... 9 
Figure 2-12 - Confirm Download Settings ..................................................................................... 10 
Figure 2-13 - Download All Secured And Archived Data Sets ...................................................... 10 
Figure 2-14 - Current Data Set Contents ...................................................................................... 11 
Figure 3–1 - Rear View of RSM Unit ............................................................................................. 15 
Figure 3-2 - Rear View of RSM Unit .............................................................................................. 16 
Figure 4-1 – VDR FRM Download Application .............................................................................. 20 
Figure 4-2 – Download Wizard FRM Setup Page ......................................................................... 21 
Figure 4-3 - Download Wizard FRM Connection Settings Page ................................................... 21 
Figure 4-4 - Download Wizard Data Management Page............................................................... 22 
Figure 4-5 – Download in Progress............................................................................................... 22 
Figure 4-6  – Download Complete................................................................................................. 23 
Figure 4-7- Establishing TCP/IP Address...................................................................................... 24 
Figure 4-8 - VDR Data Port ........................................................................................................... 24 
Figure 4-9 – Mapping the Secured Data Drive.............................................................................. 25 
Figure 4-10 – Enter Password and User name............................................................................. 25 
Figure 4-11 – The Mapped Secured Data Drive ........................................................................... 26 
Figure 4-12 - RJ45 Connector ....................................................................................................... 27 
Figure 4-13 – Client PC to Rutter-ACR Float-Free SFRM Capsule Connectivity ......................... 28 
Figure 4-14 – Installation Executable File ..................................................................................... 29 
Figure 4-15 – Setup Wizard Welcome Page ................................................................................. 29 
Figure 4-16 - Setup Wizard Component Selection Page .............................................................. 29 
Figure 4-17  – Setup Wizard Install Location Page....................................................................... 30 
Figure 4-18 – Installing the Application Files................................................................................. 30 
Figure 4-19 – Setup Completed .................................................................................................... 31 
Figure 4-20 – TCP/IP Configuration .............................................................................................. 32 
Figure 4-21 – VDR FRM Download Application ............................................................................ 32 
Figure 4-22 – Download Wizard FRM Setup Page ....................................................................... 33 
Figure 4-23 – Download Wizard FRM Connection Settings Page ................................................ 33 
Figure 4-24  – Download Wizard Data Management Page........................................................... 34 
Figure 4-25 – Download in Progress............................................................................................. 34 
Figure 4-26 – Download Complete................................................................................................ 35 
Figure 5-1 – OAU Keypad ............................................................................................................. 37 
Figure 6-1 – Installation Executable File ....................................................................................... 41 
Figure 6-2 – Choose Installation Directory .................................................................................... 41 
Figure 6-3 – Installing Message Window ...................................................................................... 42 
Figure 6-4 - Choose Installation Directory..................................................................................... 42 
Figure 6-5 - Reboot warning.......................................................................................................... 42 
Figure 6-6 – Playback Software .................................................................................................... 43 
Figure 6-7 – Configuration File Selection – Menu Item................................................................. 43 
Figure 6-8 – Restart Warning ........................................................................................................ 44 
Figure 6-9 - Locating Downloaded Data........................................................................................ 44 
Figure 6-10 - Choose a .vdr File.................................................................................................... 45 



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

IV

Figure 6-11 - Configuration file not found...................................................................................... 45 
Figure 6-12 – Unarchive Extracted Data ....................................................................................... 46 
Figure 6-13 – Enabling Ethernet Broadcasting ............................................................................. 46 
Figure 6-14 – Controls Toolbar...................................................................................................... 47 
Figure 6-15 – Choose Start Time For Playback ............................................................................ 47 
Figure 6-16 - Establishing TCP/IP Address................................................................................... 48 
Figure 6-17 - Enabling Real Time Display Mode........................................................................... 48 
Figure 6-18 - Real Time Display Mode Confirmation .................................................................... 49 
Figure 6-19 - Controls Toolbar ...................................................................................................... 49 
Figure 6-20 – Change Password................................................................................................... 50 
Figure 6-21 – Set Fast Forward Rate............................................................................................ 50 
Figure 6-22 – Audio Interface ........................................................................................................ 51 
Figure 6-23 – Audio Menu ............................................................................................................. 52 
Figure 6-24 – Depth Graph............................................................................................................ 53 
Figure 6-25 – Wind Information ..................................................................................................... 53 
Figure 6-26 – Sample Propulsion Tab........................................................................................... 54 
Figure 6-27 – MultiPilot Tab .......................................................................................................... 55 
Figure 6-28 – AIS Playback Tab.................................................................................................... 56 
Figure 6-29 – Targets Information Section.................................................................................... 57 
Figure 6-30 – View Settings Section ............................................................................................. 57 
Figure 6-31 – AIS Display Settings Window.................................................................................. 58 
Figure 6-32 - GuardZone enable/disable ...................................................................................... 58 
Figure 6-33 - Log Window ............................................................................................................. 59 
Figure 6-34 – Fire Doors Tab ........................................................................................................ 61 
Figure 6-35 – Water Doors Tab..................................................................................................... 62 
Figure 6-36 – Hull Openings Tab .................................................................................................. 63 
Figure 6-37 – Data Extraction Option............................................................................................ 64 
Figure 6-38 – Data Extraction Window.......................................................................................... 64 
Figure 6-39 – Data Stream Options w/ Video Selected................................................................. 65 
 

List of Tables 
 
Table 3-1 - Alarm Code Description .............................................................................................. 40 
Table 3-2 - USB Memory Stick and RSM OAU Status’ ................................................................. 40 
Table 4-1 - Wiring Diagram for 10BaseT Crossover Cable........................................................... 27 
Table 6-1 - Error Code - Playback Log Window............................................................................ 60 
 
 
 
 
 
 



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

V

This page is intentionally blank.



Rutter VDR—100G3/G3S Data Recovery Manual 
 

VDR-100G3/G3S Data Recovery Manual  06/06/2008 16:09:00 
RUT-UM-10-003 Rev. 1.0 

VI

Manual Notes 
 
 
VDR-100G3S Reference 
Please note that while this manual references the VDR-100G3, it is also applicable to the 
Simplified Voyage Data Recorder (VDR-100G3S) unless otherwise stated.  The VDR-100G3S 
has many similar components to the VDR-100G3, with the following differences: 
 

 The Video Module is only required if the vessel’s radar has an available COTS 
(commercial off-the-shelf) interface. Therefore, the recording of video data may not be 
applicable in some VDR-100G3S installations. 

 The VDR-100G3S has an accompanying Simplified FRM (SFRM) capsule. 
 
 
Software Reference 
Software procedures in this manual are based upon a PC running a Windows XP operating 
system. There may be minor differences depending on the operating system and configuration in 
use on the Client PC. 
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1 Introduction to Data Recovery for the Rutter 
VDR-100G3/G3S  

 
The Rutter VDR-100G3/G3S is designed to collect and maintain a secure, retrievable record of 
information related to the position, movement, physical status, and command and control of a 
marine vessel.  It maintains a continuous record of the most recent 12 hours of activity in the Data 
Processing Unit (DPU).  This is referred to as the Current Data Set. The current data set is not 
affected by any method of copying, backing up or downloading data.   
 
In addition to the current data, the VDR-100G3 offers 5 methods of storing copies of the data:   
 

1. The DPU contains an internal hard drive capable of retaining multiple copies of 12 hour 
data sets.  Emergency backup of data initiated at the Operation & Alarm Unit (OAU) 
creates Secured Data directories on this drive named according to the date and time of 
backup.  Each data backup is referred to as a Secured Data Set.   

 
Secured data may be copied to a download PC via Ethernet LAN connection using Rutter 
Technologies proprietary download software.  Refer to Chapter 2:Client PC Download—
Data Retrieval Method Number 1 for instructions on retrieving data from this internal hard 
drive. 
 

2. The DPU contains an internal hard drive capable of retaining multiple copies of 12 hour 
archived data sets.  The DPU will create an archived data set every 12 hours, capturing 
the most recent 12 hours of recorded data. The archiving operation creates Archived 
Data directories on this drive named according to the date and time of archive operation.  
Each data archive is referred to as an Archived Data Set.   

 
Archived data may be copied to a download PC via Ethernet LAN connection using 
Rutter Technologies proprietary download software.  Refer to Chapter 2: Client PC 
Download—Data Retrieval Method Number 1 for instructions on retrieving data from this 
internal hard drive. 

 
3. The DPU stores the most current 4 GB of recorded data to the Rutter USB Memory Stick. 

When the USB Memory Stick is full, the oldest data on it is over-written with new data. 
 

Current, Secured or Archived data sets can be copied to the Rutter USB Memory Stick. 
This operation is manually initiated via the OAU.  Refer to Chapter 3 – USB Memory Stick 
(or Optional RSM)—Data Retrieval Method Number 2 for instructions on downloading 
data to and retrieving data from the USB Memory Stick. 

 
4. Multiple data sets can be copied to the optional Remote Storage Module (RSM), if 

connected.   Refer to Chapter 3 – USB Memory Stick (or Optional RSM)—Data Retrieval 
Method Number 2 for instructions on downloading data to and retrieving data from the 
RSM. 

 
5. The fifth method of storage is the Final Recording Medium (FRM) or capsule.  This IMO 

required data storage method should only be attempted when the above-listed 
methods (1) and (2) are not available (i.e., in a situation where the VDR-100G3 is no 
longer functioning due to a major incident.)  Refer to Chapter 4 – FRM/SFRM 
Download—Data Retrieval Method Number 3  for instructions on retrieving data from the 
FRM. 
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Once the data has been copied, it may be necessary to contact the ship’s owner / operator or 
Rutter Technologies Inc. to obtain download and playback software or information necessary for 
viewing the data.  Contact information is available in Appendix C of this document.  The name 
and IMO number of the vessel involved will be required in order to provide appropriate files and 
information. 
  
If the FRM must be recovered after an incident, it may be necessary to contact the FRM 
manufacturer for assistance to reconstruct and/or refurbish the unit before it is possible to 
download data from the capsule. (Refer to Chapter 4 – FRM/SFRM Download—Data Retrieval 
Method Number 3 ). 
 

NOTE! The configuration file <config.txt> used to correctly interpret playback data, 
is contained in the root directory of all data sets and in the FRM capsule memory. 
Therefore, the vessel owner only needs to provide the configuration file when the 
data has been received on a storage medium other than the RSM and/or FRM. 

 
 
The IMO Guidelines on Voyage Data Recorder (VDR) Ownership and Recovery white paper is 
available in Appendix D of this document. 
 

NOTE!  While this manual references the VDR-100G3, it is also applicable to the 
Simplified Voyage Data Recorder (VDR-100G3S) unless otherwise stated.
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2 Client PC Download—Data Retrieval Method 
Number 1 

 
 
The Client PC Download is designed for convenient downloading of VDR-100G3 data for 
immediate playback or the storage on a separate recordable medium. 
 
The Client PC is connected to the Data Management Module (DMM) via an Ethernet 
connection.  The Client PC can download data to a recordable medium, such as a writeable CDs,  
at any time during normal VDR-100G3 operation. This will not interrupt the system’s 
recording process.  
 
NOTE: A typical data set is too large to be recorded to a single CD and will need to be split into 
shorter segments, occupying several discs, if it is to be removed from the client PC via a CD. 
 

2.1 Minimum Client PC Requirements 
The minimum requirements for a Client PC include: 

 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or  

larger and supports a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended). 

 
 

NOTE! If the Client PC is being installed on the bridge of the vessel, it must be IEC 
60945 certified. 

 
 
To review downloaded data for playback, contact the vessel owner with vessel specific 
information (i.e., vessel name and IMO number). With this information the vessel owner can use 
the necessary files and software for proper data interpretation. If a vessel owner is unable to 
provide the required files, it will be necessary to contact Rutter Technologies Inc. (contact 
information is available in Appendix C of this document).
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2.2 Installation of Download Software on Client PC 
There are 2 steps necessary to install the Download application on the Client PC: 
 

1. Copy the Download application <VDR_Download.exe> from the supplied media to the 
desktop of the download computer, or if an install file is supplied, double-click the Install 
VDR Download.exe file. 

 
2. Configure the download computer as a ‘Client’ for the ‘Download Application’ to connect 

to the VDR-100G3 and retrieve the recorded data. To do this, the download PC must be 
in the same IP segment as the download port on the VDR. The VDR’s download port 
occupies IP address 200.200.200.200. The client PC must be in the same range, with 
the last segment different than the VDR (as shown below.) To change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 
c) Right-click on the Local Area Connection icon and select Properties from the 

pop-up menu. 
d) In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 2-1 - Establishing TCP/IP Address 
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2.3 Connecting to the VDR 
To connect the Client PC to the VDR, complete the following steps: 
 

1. Locate the VDR Data Port, a RJ45 wall jack, mounted on the bridge. 
 

 
Figure 2-2 - VDR Data Port 

 
2. Connect the Client PC to the VDR Data Port using a straight-through Ethernet cable. 

 
Note! Ensure the time setting on the Client PC is set to GMT (Greenwich Mean 
Time) and the daylight savings time setting is disabled. To change these settings, 
double-click the clock in bottom right corner of the Windows desktop, select the 
‘Time Zone’ tab, select “(GMT) Greenwich Mean Time” from the time zone drop-
down menu and ensure the “Automatically adjust clock for daylight savings 
changes” checkbox is not checked. 

 
 
 

2.4 Starting the Download Process 
Start the download utility by double-clicking the download.exe icon located on the Windows 
desktop. See Figure 2-3 - Download Software Main Screen for an example of the download utility. 
 

 
Figure 2-3 - Download Software Main Screen 
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2.4.1 Download The Current Data Set 
Complete the following steps to begin the download of the current data set: 
 

1. Select ‘Download Current Dataset’ from the ‘Download Controls’ menu. 
 

 
Figure 2-4 - Download Controls Menu 

 
 

2. Enter a password when prompted. 
 
3. Once prompted with the ‘Download Settings’ window (see Figure 2-5 - Download 

Settings Window), choose from the following available settings: 
 ‘Download complete data set’. 
 ‘Download partial data set’ – once this option has been chosen, ‘Start’ and ‘Stop’ 

times become available. Using the appropriate slide-bar, set the time frame that 
will begin and end the downloaded data set.. 

 

 
Figure 2-5 - Download Settings Window 

 
4. Confirm that the stated download destination is correct. If it is not, press the ‘Change 

Destination’ button, select the correct destination from the file window, and press ‘OK’. 
 
5. Press the ‘Start Download’ button. 
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6. Confirm all settings are correct in the confirmation window and press ‘OK’ (if they are 
not, press ’Cancel’ and make the appropriate changes in the ‘Download Settings’ 
window). 

 
 

 
Figure 2-6 - Sample Download Directory 

Once a download is complete, “MainAudio”, “MainNMEA”, and “MainVideo” folders are visible.  
The vdrparams.ini and vdr-cfg.txt files are also downloaded and saved to the specified download 
directory.  See Figure 2-6 - Sample Download Directory for an example of a typical download 
directory. 

2.4.2 Download A Secured Data Set 
Complete the following steps to download one (1) of multiple secured data sets from the DMM’s 
internal hard drive: 
 

1. Select ‘Download Secured Dataset’ from the ‘Download Controls’ menu. 
 
2. A download progress window will appear indicating that the application is receiving 

information from the DMM. 
 

3. In the subsequent ‘Download Secured Datasets’ window, all available secured data sets 
will be visible. Each data set shows the date it was initially secured, file size, and start 
and end time. 

 

 
Figure 2-7 - Download Secured Data Sets 

4. Select the appropriate data set from the list. 
 
5. To download a complete data set, choose the “Download complete data set” radio button 

under ‘Download duration’. To download a partial data set, choose “Download partial 
data set”. 

 



Chapter 2: Client PC Download—Retrieval Method Number 1 
 

VDR-100G3/G3S Data Recovery Manual  3/24/2008  
RUT-UM-10-003 Rev. 1.0 

8

6. If choosing to download a partial data set, a window will appear from which the time 
range to be downloaded must be chosen. The associated scroll bar is used to select a 
start and/or end time (the exact time may also be entered directly in to the time fields.) 

 

 
Figure 2-8 - Partial Download Window 

7. To choose a directory to which the data sets will be downloaded, other than the one listed 
under ‘Destination’, press the “Change Destination” button and follow standard Windows 
procedure for selecting a desired directory. 

 
8. Once the duration and destination are correct, press ‘Start Download’. 

 
9. Enter a password and press ‘OK’. 

 
10. A “Download Settings” dialog will appear providing confirmation information for the data 

set to be downloaded. If all information is correct, press ‘OK’ to begin the download. 
 

 
Figure 2-9 - Confirm Download Settings 
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2.4.3 Download An Archived Data Set 
 
Complete the following steps to download one of multiple archived data sets from the DMM’s 
internal hard drive: 
 

1. Select ‘Download Archived Dataset’ from the ‘Download Controls’ menu. 
 
2. A download progress window will appear indicating that the application is receiving 

information from the DMM. This operation may take several minutes to complete. 
 

3. In the subsequent ‘Download Archived Datasets’ window, all available archived data sets 
will be visible. Each data set shows the date it was initially archived, file size, and start 
and end time. 

 

 
Figure 2-10 - Download Archived Data Sets 

4. Select the appropriate data set from the list. 
 
5. To download a complete data set, choose the “Download complete data set” radio button 

under ‘Download duration’. To download a partial data set, choose “Download partial 
data set”. 

 
6. If choosing to download a partial data set, a window will appear from which the time 

range to be downloaded must be chosen. The associated scroll bar is used to select a 
start and/or end time (the exact time may also be entered directly in to the time fields.) 

 

 
Figure 2-11 - Partial Download Window 
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7. To choose a directory to which the data sets will be downloaded, other than the one listed 

under ‘Destination’, press the “Change Destination” button and follow standard Windows 
procedure for selecting a desired directory. 

 
8. Once the duration and destination are correct, press ‘Start Download’. 

 
9. Enter a password and press ‘OK’. 

 
10. A “Download Settings” dialog will appear providing confirmation information for the data 

set to be downloaded. If all information is correct, press ‘OK’ to begin the download. 
 

 
Figure 2-12 - Confirm Download Settings 

2.4.4 Download All Current, Secured And Archived Data Sets 
The VDR Download Application allows the user to select the option to download all Current, 
Secured and Archived data sets from the G3/G3S in one operation. To achieve this, the 
destination drive for the data must have sufficient capacity and free drive space to accommodate 
up to 160GB of VDR data. If there is insufficient available drive space, the operation will terminate 
before all data is copied off of the VDR. 
 
NOTE: As this is can be a large copy operation (up to 160 GB), please allow sufficient time for the 
operation to complete. In the case of 160GB of data to copy, it could take up to 2.5 to 3 hours to 
complete. 
 
Complete the following steps to download all of the current, secured and archived data sets from 
the DMM’s internal hard drive: 
 

1. Select ‘Download All secured And Archived Datasets’ from the ‘Download Controls’ 
menu. 

 
2. A download progress window will appear indicating that the application is receiving 

information from the DMM. This operation may take several minutes to complete. When 
complete, the VDR Download Application will display the total number of Secured and 
Archived data sets available for download in the main log window. 

 

 
Figure 2-13 - Download All Secured And Archived Data Sets 
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3. To choose a directory to which the data sets will be downloaded, other than the one listed 
under ‘Destination’, press the “Change Destination” button and follow standard Windows 
procedure for selecting a desired directory. 

 
4. Once the destination is correct, press ‘Start Download’. 

 
 
5. Enter a password and press ‘OK’ to begin the download. 
 
The download begins by downloading all available Secured data sets, in order of date and 
time secured, beginning with the oldest and ending with the most recent. Following the 
download of the most recent Secured data set, the download of all available Archived data 
sets commences. The download of the Archived data sets also occurs in order of date and 
time archived, beginning with the oldest and ending with the most recent. 

 

2.4.5 Get Current Data Set Contents 
This option allows the user to verify the contents of the current data on the VDR internal Hard 
Drive. It displays the time range of the Video, Audio and NMEA data contained in the VDR_DATA 
folder. 

 
Figure 2-14 - Current Data Set Contents 

2.4.6 Error Log and Battery Log 
To download the error log or battery log file, select the applicable item (‘Download Error Log’ or 
‘Download Battery Log’) from the ‘Download Controls’ menu.  The system will prompt the user to 
select a location to save the log file. 

2.5 Complete vs. Partial Download 
A ‘complete’ download is the process of downloading a full 12-hour data set from the DMM. As a 
user may want only a ‘partial’ download, a ‘Download partial data set’ option is available. Select 
either ‘Download complete data set’ or ‘Download partial data set’ in the ‘Download Settings’ 
window (see Figure 2-5 - Download Settings Window) to download the desired data set. 

2.6 Disconnecting from the VDR 
To disconnect, simply choose ‘Exit’ from the ‘File’ menu.  
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3 USB Memory Stick (or Optional RSM)—Data 
Retrieval Method Number 2 

 
Normally when the G3 is installed the USB Memory Stick is connected to the USB port located in 
the front compartment of the DPU  
 

3.1 Copying Data to a USB Memory Stick (or optional 
RSM) 

 
Normally when the G3 is installed the 
USB Memory Stick is connected to the 
USB port located in the front 
compartment of the DPU.  

 
For copying data to the removable 
USB Memory Stick, (or RSM) press 
“Enter” after you have selected the 
desired data set. Depending on the 
amount of data to be copied, and the 
free memory space available, you 
may have to acknowledge a display 
prompt.  
 
The USB Memory Stick will typically 
hold 2 data sets of 12 hours each 
(dependant on the data set size). 
 

 
 
 
 
Warning: Before performing a Copy function, make sure the USB Memory Stick 
(or RSM) does not contain data which you want to keep. Before copying it is 
recommended that the operator: 

1. “Eject” the USB Memory Stick using the OAU keypad,  
2. Physically remove the USB Memory Stick from the DPU,  
3. Copy the USB Memory Stick contents to an external computer, 
4. Return the USB Memory Stick to the DPU compartment. 

 
Warning: Before performing a Copy All operation, the USB Memory Stick should 
be replaced with the RSM having sufficient storage capacity to copy all the 
contents of the DMM hard drive. This could be as much as 160GB.  

 
 
Note: The copy process may take from several minutes to several hours, depending on the 
amount of data to be copied. The progress of the recording is displayed on the OAU LCD as a 
percentage. 
 
If the copy process has finished, failed or been cancelled manually, the OAU LCD will display 
“USB: Stby”. The USB Memory Stick will not immediately resume normal operation. After 
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one hour, if the USB Memory Stick has not been ejected from the system, the system will delete 
all data on it and resume the data recording process to it. 
 
If the system has no USB Memory Stick nor other USB storage device with sufficient free space 
connected, the display will show the error message “Removable Storage Drive Absent.” 
 

 
 Warning: The following situations will result in all data being deleted from the 
USB Memory Stick: 
 
 

1. When the USB Memory Stick is ejected and physically removed from the system, and 
then re-connected, the VDR will erase all the data on the USB Memory Stick and begin 
recording data to it again; 

 
2. When data is downloaded or copied to the USB Memory Stick, if the drive is NOT ejected 

and physically removed within 1 hour after the download is complete, then the VDR will 
erase all data on the USB Memory Stick and begin recording data to it again; 

 
3. When the USB Memory Stick is unplugged from the system, without first ejecting it, and 

then it is  re-connected, then the VDR will erase all data on the USB Memory Stick and 
begin recording data to it again; 

 
4. When attempting to download or copy a data set to the USB Memory Stick, if there is 

insufficient memory, then the VDR will erase all data on the USB Memory Stick in an 
attempt to free enough memory for the download to succeed. 

 

3.2 Connecting the USB Memory Stick 
 
To connect the USB Memory Stick, insert it into the available USB port. The system will detect 
the drive and the OAU will display a USB Memory Stick status of “USB: STBY”. After at least 10 
seconds, the system will begin recording to the USB Memory Stick and the OAU will display a 
USB Memory Stick status of “USB: REC”. 
 

 
Once the USB Memory Stick RSM is physically connected, the DMM will 
automatically detect it and begin the recording process to it. As part of this process, 
all data on the USB Memory Stick will be deleted. 
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3.3 Connecting the RSM 
 
To connect the RSM, once the USB Memory Stick has been properly ejected and physically 
removed, complete the following steps: 
 

1. Attach the USB 2.0 cable from the RSM to the USB 2.0 port in the compartment in the 
front panel of the DPU; 

2. Connect the AC power cable  to the RSM; 
3. Power on the RSM (switch RSM Power  to “On” position); 

 
 
 

 
Figure 3–1 - Rear View of RSM Unit 

 
The system will auto-detect the RSM and the OAU will display the status as “USB: STBY”. 
 

 
Once the RSM is physically connected, the DMM will automatically detect it. As 
part of this process, all data on the RSM will be deleted. 
 

 

3.4 Disconnecting the USB Memory Stick or RSM 
 
The process to disconnect/eject the USB Memory Stick or RSM must be performed prior to 
physically disconnecting the unit from the system. 
 

Important! Do not physically disconnect the USB Memory Stick or RSM before 
ejecting it from the system via the OAU. Failure to eject the drive properly will 
trigger a “REMOTE ERROR” on the OAU. This error can be cleared only by re-
connecting the improperly removed drive (See Sections Connecting the USB 
Memory Stick and Connecting the RSM).  
Warning: Failure to properly eject the drive may result in disk corruption. 
 
It is recommended to POWER OFF the RSM BEFORE physically disconnecting it. 
 

 
To disconnect the USB Memory Stick (USB) or RSM, the following steps must be completed: 
 

1. Press the “Eject” button on the OAU menu pad; 
2. Press “Enter” to select the “USB” option on the OAU display; 
3. The OAU will display the message “Disconnecting” indicating that the 

operator should wait while the USB Memory Stick or RSM is disconnected. 
4. The OAU will then display a message “USB Archiving has been 

disabled for 1 hour”, meaning that which indicated it is safe to remove the 
external device; 

Power Input 

Ethernet Port 
(NOT USED) 

Power Switch 

USB 2.0 Input 
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5. After approximately 10 seconds the OAU will display the message “USB: 
Stby” for up to 1 hour, until the device is removed or disconnected; 

6. To remove the USB Memory Stick open the USB compartment cover on 
the DPU and unplug the USB Memory Stick; 

7. To disconnect an RSM, turn off RSM power and uplug the RSM cable from 
the USB compartment on the DPU. 

 
NOTE: After the OAU LCD displays “USB: STBY” then the USB Memory Stick 
should be removed immediately. If the USB Memory Stick is NOT unplugged  
within 1 hour after the eject operation the VDR – 100G3 will erase all data on the 
USB Memory Stick and begin recording data to it again. 
 

 
 
 

 
Figure 3-2 - Rear View of RSM Unit 

 

3.5 Re-connecting the USB Memory Stick or RSM 
 
To connect the USB Memory Stick, insert it into the USB compartment of the DPU or connect the 
power and data cables to the RSM.  
 
The system will detect the drive and the OAU will display “USB: Stby” If connecting a USB 
Memory Stick, after at least 10 seconds, the system will begin recording to the USB Memory Stick 
and the OAU will display a “USB: Rec”  
 

 
Once the USB Memory Stick is physically connected, the VDR will automatically 
detect it and begin the recording process to it. As part of this process, all data on 
the USB Memory Stick will be deleted.  
 
Once the RSM is physically connected, the VDR will automatically detect it. As part 
of this process, all data on the RSM will be deleted. 

 
 

Power Input 

Ethernet Port 
(not used) 

USB 2.0 Port 

Power Switch 
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3.6 Connecting the Client PC to the USB Memory Stick 
 
To retrieve data from the USB Memory Stick using the client PC complete the following steps: 
 

1. Plug the USB Memory Stick in to an available USB 2.0 port on the client PC. 
2. The USB Memory Stick will be visible on the Client PC as a connected USB drive. 

 
Note: A USB 1.1 port may also be used but it takes much longer to transfer the data than a 2.0 
port. 
 
The VDR - 100G3 Playback Application may be used to view the data. 

3.7 Connecting Client PC to RSM 
 
To retrieve data from the RSM using the Client PC, complete the following steps: 
 

1. Connect the RSM to an available USB 2.0 port on the client PC using an “A to B” USB 
cable; 

2. The RSM will be visible on the Client PC as a connected USB drive. 
 

The VDR - 100G3 Playback Application may be used to viewthe data.   
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4 FRM/SFRM Download—Data Retrieval Method 
Number 3  

 
 
Recovery of data from the FRM/SFRM should only be carried out in a situation where an 
incident has rendered the VDR inoperative. Data recovery must be carried out according to the 
manufacturer’s instructions, using proprietary software provided by Rutter Technologies Inc. 
 
The VDR-100G3 can currently accommodate the Rutter FRM (RUT-02447) Fixed Capsule or the 
L3 HVR-01/ 02 Fixed FRM Capsule. The VDR-100G3S can currently accommodate the Rutter 
FRM (RUT-02447) Fixed Capsule, the L3 SVR-01/02, the Jotron Float-Free SFRM Capsule, and 
the Rutter-ACR Float-Free SFRM Capsule. 
 
Once the FRM/SFRM capsule has been recovered, dependant upon the severity of the incident, it 
may be necessary to contact the capsule manufacturer in order to reconstruct and/or refurbish 
the unit before downloading may commence. Contact information for the FRM/SFRM 
manufacturer mentioned above is available in Appendix C – Contact Information. 
 
It will also be necessary to contact Rutter Technologies Inc., providing the vessel name and IMO 
number in order to receive the necessary download, playback, configuration, and partition 
information files (contact information is available in Appendix C of this document).  Appendix A – 
Incident Data Recovery Checklist provides a guideline of steps to be carried out by the incident 
investigation team in the event that they may have to recover a FRM/SFRM unit. 
 
The following procedure should only be attempted by an authorized service technician and is not 
required for day-to-day operations. 

4.1 Damage to Ship and Minor Damage to FRM/SFRM 
The VDR-100G3 is capable of downloading data directly from the FRM/SFRM. Therefore, if the 
VDR-100G3 can communicate with the FRM/SFRM, data can be retrieved using the VDR-100G3 
as the Client PC. 
 
If preferred, or if damage makes VDR-FRM/SFRM communication impossible, the methods 
described in Section Error! Reference source not found. - Error! Reference source not 
found.may also be employed to retrieve the FRM/SFRM data. 
 

Note! Before downloading from an L3 HVR/SVR capsule, it is essential to have the 
capsule’s partition information. In the case of an incident, please contact Rutter 
Technologies Inc. for further instructions on obtaining the correct partition 
information. 

4.1.1 Downloading FRM/SFRM Data Directly to the VDR-100G3 
In the case where the VDR-100G3 can communicate with the FRM/SFRM, the VDR-100G3 may 
be used to download data directly from the FRM/SFRM. After the data is downloaded, it may then 
be copied off of the VDR-100G3 internal storage drive to a Playback PC. The following steps 
outline the procedure to download data directly to the VDR-100G3. 
 

Note! Before downloading directly to the VDR-100G3, it is necessary to stop the VDR-
100G3 Watchdog Application and the VDR-100G3 Record Application. The Investigator 
must then log out of the MyUser account, and then log in to the VDR-100G3 as 
Administrator. Please contact Rutter Technologies Inc. for further instructions on 
obtaining the correct username and password information.
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4.1.1.1 Downloading Data Using the FRM Download Application 
As Administrator on the VDR-100G3, use the FRM Download Application to download data 
directly from the FRM/SFRM. The following steps outline the procedure to use the FRM 
Download Application the retrieve data from an FRM/SFRM: 

 
1.  Start the FRM Download Application by clicking “Start”, “All Programs”, “Rutter”, “VDR”, and 

finally “FRM Download”. Alternatively, locate the FRM Download.exe file in the VDR-100G3 
‘C:\VDRApps\’ folder, and double-click to start the application. 

 

 
Figure 4-1 – VDR FRM Download Application 

 
 
2. From the “Download” Menu select “Download Wizard…”. Select the FRM/SFRM type for this 

download session from the list of FRM/SFRMs on the first page of the Download Wizard 
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Figure 4-2 – Download Wizard FRM Setup Page 

 
3. Select “Use default settings to connect to FRM” and click next. 
 

 
Figure 4-3 - Download Wizard FRM Connection Settings Page 

 
4. Select the data types you wish to download (Ensure all are selected). 
 
5. Use the ‘Browse’ button to select a suitable location to extract the contents of the FRM/SFRM 

to. When downloading directly to the VDR-100G3, it is recommended that the data be 
downloaded to the ‘E:\’ drive. This directory is ‘shared’ and is accessible to a Playback PC via 
the download port on the VDR-100G3. Alternatively, data may be copied directly to an 
attached RSM or USB Memory Stick. 

 
 

Note! In either case, there must be sufficient free memory space to accommodate 
the entire downloaded data set. This may require up to 4GB of free memory space, 
dependant on the FRM/SFRM being downloaded. 
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Figure 4-4 - Download Wizard Data Management Page 

6. Enter the password to begin the download process. The default password is ‘VDR’ (case 
sensitive). 

 
 

Note! Depending on the FRM/SFRM design, the download process may take 
anywhere from 15 minute up to 4 hours. 

 
 

 
Figure 4-5 – Download in Progress 



Chapter 4: FRM/SFRM Download—Data Retrieval Method Number 3 
 

VDR-100G3/G3S Data Recovery Manual  3/24/2008  
RUT-UM-10-003 Rev. 1.0 

23

7. When the download has completed successfully, a message will appear in the log window of 
the FRM Download application indicating the download has completed along with the elapsed 
download time and the average speed of the download. 

 

 
Figure 4-6  – Download Complete. 

 
8. Once the download is complete, disconnect from the FRM/SFRM by selecting ‘Exit’ from the 

‘File’ menu. 
 

9. The downloaded data may now be moved to a Playback PC running the Rutter Playback 
software for review. See Section 4.1.1.2 Copying the Downloaded Data to a Playback PC for 
details. 

4.1.1.2 Copying the Downloaded Data to a Playback PC  
With the data now downloaded to the VDR-100G3, it may now be moved to a Playback PC 
running the Rutter Playback Application for review. See Chapter 6 - Playback Software for details 
of installing and using the Rutter Playback software, 

4.1.1.2.1 Copying The Downloaded Data Via Drive Mapping 
If the FRM/SFRM data was downloaded to the VDR-100G3’s ‘E:\’ drive, connect the Playback PC 
to the VDR-100G3’s Download Ethernet port to retrieve the data. The following steps illustrate 
this procedure: 
 
1. The Playback PC must be in the same IP segment as the VDR-100G3’s Download Ethernet 

port. The VDR-100G3’s Download Ethernet port occupies IP address 200.200.200.200. The 
Playback PC must be in the same range, with the last segment different than the VDR-
100G3 (as shown below.) To change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 
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c) Right-click on the Local Area Connection icon and select Properties from the 
pop-up menu. 

d) In the Local Area Connection Properties window, highlight “Internet Protocol 
(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 4-7- Establishing TCP/IP Address 

 

2. Locate the VDR Data Port, a RJ45 wall jack, mounted on the bridge. 
 

 
Figure 4-8 - VDR Data Port 

 

 
3. Connect the Playback PC to the VDR Data Port via a straight-through Ethernet cable. 
 
4. Via Windows Explorer, select ‘Tools>Map Network Drive’. Select a drive letter not in use by 

the Playback PC, and enter ‘\\200.200.200.200\Secured Data’ in the ‘Folder’ text box. 
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Figure 4-9 – Mapping the Secured Data Drive 

 
 

5. When prompted, enter ‘MyUser’ for the user name and ‘Rutter’ for the password. Please note 
that these entries are case-sensitive. 

 

 
Figure 4-10 – Enter Password and User name 

 
6. When the Playback PC connects to the ‘Secured Data’ drive on the VDR-100G3, it will 

appear in Windows Explorer. 
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Figure 4-11 – The Mapped Secured Data Drive 

 
7. Select the downloaded data set of interest, and copy it to the Playback PC. 

4.1.1.2.2 Copying the Downloaded Data Via RSM/USB Memory Stick 
If the FRM/SFRM data was downloaded to the VDR-100G3’s RSM or USB Memory Stick, the 
investigator can copy the data directly to the Playback PC. 
 
Remove the device containing the downloaded data from the VDR-100G3, and connect it to the 
Playback PC. When connected, the downloaded data may be copied off of the device, or the 
Playback software may be used to play back the data directly off of the device.  

4.1.2 Downloading FRM/SFRM Data Direct to Playback/Client PC 
Even if the VDR-100G3 is capable of downloading data directly from the FRM/SFRM (i.e. there is 
VDR-FRM/SFRM communication), it may be preferred to download the FRM/SFRM data directly 
to the Client/Playback PC. If this is the case, use the methods described in   Section 4.2: No VDR 
Communications with FRM/SFRM to retrieve the FRM/SFRM data. 
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4.2 No VDR Communications with FRM/SFRM 
If the FRM/SFRM is intact but is unable to communicate with the VDR-100G3, it is possible to 
connect a Client/Playback PC to the FRM/SFRM and download the recorded data directly to it. To 
download data directly from the FRM/SFRM to a Client PC, the Client PC must have the 
following: 
 

 A 100 Base-TX Ethernet Interface (RJ45). 
 Rutter Technologies Inc. proprietary FRM Download Application software. 

 
 

Note! The following information is only applicable to the Rutter FRM (RUT-02447) 
Fixed Capsule, the L3 HVR/SVR Fixed FRM/SFRM Capsule and the Rutter-ACR 
Float-Free SFRM Capsule.  For information on connecting to the Jotron Float-Free 
SFRM Capsule, refer to the manufacturer’s technical manual.  

 

4.2.1 Connecting to Rutter FRM (RUT-02447) or L3 HVR/SVR Fixed 
FRM/SFRM Capsules 

 
1. Locate the capsule and its associated FRM Junction Box. 
2. Remove the power and Ethernet cable from the Junction Box. 
3. Connect the power cable to a 24V power source. 
4. Using the information in Table 4-1 - Wiring Diagram for 10BaseT Crossover Cable  below, 

adjust the wiring of the existing Ethernet cable to make it a crossover cable and add a RJ45 
connector. 

5. Connect the RJ45 connector to the Client PC. 

 
Figure 4-12 - RJ45 Connector 

 
Pinout Striped Colour Solid Colour 

Pin 1 (TD+) ---------------------- (RD+) Pin 3 White/Orange Green 

Pin 2 (TD+) ----------------------- (RD-) Pin 6 Orange Yellow 

Pin 3 (TD+) ----------------------- (TD+) Pin 1 White/Green Blue 

Pin 4 ---- (Not used by 10BaseT) ---- Pin 4 Blue Red 

Pin 5 ---- (Not used by 10BaseT)----- Pin 5 White/Blue Black 

Pin 6 (RD-) ------------------------- (TD-) Pin 2 Green Orange 

Pin 7 ----- (Not used by 10BaseT)---- Pin 7 White/Brown Brown 

Pin 8 ----- (Not used by 10BaseT) --- Pin 8 Brown Grey 

Table 4-1 - Wiring Diagram for 10BaseT Crossover Cable 
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NOTE! It is important to remember that Pins 1 & 2 are a twisted pair and Pins 3 & 
6 are a twisted pair. 

4.2.2 Connecting to a Rutter-ACR Float-Free SFRM Capsule 
The Rutter-ACR Float-Free SFRM Capsule uses PoE technology to provide power and data 
connectivity between it and the VDR-100G3. The following steps illustrate how to connect the 
Rutter-ACR Float-Free SFRM Capsule directly to a Client PC: 
1. Locate the Rutter-ACR Float-Free SFRM Capsule and its associated PoE Power Injector 

(PS-100). The PoE Power Injector is located inside the DPU. 
2. Remove the power and Ethernet cable between PoE Power Injector and the DMM and DPU 

power terminal block, respectively. 
3. Connect the power cable to a 24V power source. 
4. Connect the RJ45 connector to the Client PC. The Ethernet connection may be made with 

the existing Ethernet cable. It is not necessary to change either of the Ethernet cables from 
straight-through to cross-over or from cross-over to straight-through. 

 
Figure 4-13 – Client PC to Rutter-ACR Float-Free SFRM Capsule Connectivity 

4.2.3 Connecting to a Jotron Float-Free SFRM Capsule 
For information on connecting to the Jotron Float-Free SFRM Capsule to a Client PC, refer to the 
manufacturer’s technical manual. 

4.2.4 Installing the FRM Download Application 
Prior to downloading data from the FRM/SFRM directly to the Client PC, the FRM Download 
Application must be installed on the Client PC. The installation of the FRM Download Application 
is mostly automated and requires little user interaction. The install is performed via a self-
extracting executable file and is installed to C:\Program Files\Rutter\FRM Download\ by default. 
There will be a shortcut added to the Start menu upon completion of the installation. 
 
To complete the installation of the FRM Download Application, complete the steps listed below: 
 
1. Copy the FRM Download Application installer (FRM Download Setup.exe) from the VDR 

Data Recovery CD supplied by Rutter Technologies Inc. to the desktop of the Client PC. 
2. Once copied, locate the file entitled ‘FRM Download Setup.exe’ and double-click it. 
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Figure 4-14 – Installation Executable File 

3.  Read the information on the welcome page of the setup wizard and click ‘next’. 
 

 
Figure 4-15 – Setup Wizard Welcome Page 

4. The ‘Choose Components’ page there will be an option to include or exclude ‘Windows  
Services for Unix’. This option should be checked when using the FRM Download Application 
with a Rutter Fixed Capsule. Otherwise, this option can be unchecked. 

 

 
Figure 4-16 - Setup Wizard Component Selection Page 
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5. Choose the directory to which the FRM Download Application will be installed and click 
‘Install’ to proceed with the installation. 

 
Note! Due to limitations with the installation process of ‘Windows Services for 
Unix’, this component will be installed to “C:\SFU” by default. 

 
 
  

 
Figure 4-17  – Setup Wizard Install Location Page 

 
6. Installation will proceed until the process is completed 
 

 
Figure 4-18 – Installing the Application Files 
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7. Once the FRM Download Application setup wizard has completed, click ‘Finish’ to complete 
the installation process. 

 

 
Figure 4-19 – Setup Completed 

4.2.5 Copy VDRPARAMS.INI 
Copy the ‘vdrparams.ini’ file to the ‘C:\WINDOWS’ folder from the VDR Data Recovery Software 
CD supplied by Rutter Technologies Inc. 

4.2.6 Setting the Client PC IP Address 
The IP address of the Client PC must be altered to match the IP of the FRM/SFRM (excluding the 
last segment). The FRM/SFRM IP is provided in the vdrparams.ini file.  

1. To change the Client PC’s IP address, open the ‘Control Panel’ > ‘Network and Dial-up 
Connections’ > ‘Local Area Connection’ and click the ‘Properties’ button. 

2. In the subsequent ‘Local Area Connection Properties’ window select ‘Internet Protocol 
(TCP/IP) in the ‘Components checked are used by this connection:’ selection area and 
click the ‘Properties’ button. 

3. In the subsequent ‘Internet Protocol (TCP/IP) Properties’ window, select the ‘Use the 
following IP address’ radio button and enter the appropriate FRM/SFRM IP address in 
the ‘IP Address:’ field. 

4. The last segment will have to be changed to a number between 3 and 255, but cannot 
be the same number as the FRM/SFRM IP address (i.e., if the FRM/SFRM IP address is 
192.168.0.2, the Client PC address may be entered as 192.168.0.3). 
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Figure 4-20 – TCP/IP Configuration 

4.2.7 Downloading Data Using the FRM Download Application 
After installing the FRM Download Application, it can be used to download data directly from the 
FRM/SFRM to the Client PC. The following steps outline the procedure to use the FRM Download 
Application the retrieve data from an FRM/SFRM: 
 

Note! Before downloading from an L3 HVR/SVR Fixed FRM/SFRM, it is essential 
to have the capsule’s partition information. In the case of an incident, please 
contact Rutter Technologies Inc. for further instructions on obtaining the correct 
partition information. 

 
 

1.  Start the FRM Download Application by clicking “Start”, “All Programs”, “Rutter”, “VDR”, and 
finally “FRM Download”. 

 

 
Figure 4-21 – VDR FRM Download Application 
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2. From the “Download” Menu select “Download Wizard…”. Select the FRM/SFRM type for this 

download session from the list of FRM/SFRMs on the first page of the Download Wizard 
 

 
Figure 4-22 – Download Wizard FRM Setup Page 

3. Select “Use default settings to connect to FRM” and click next. 
 

 
Figure 4-23 – Download Wizard FRM Connection Settings Page 

 
4. Select the data types you wish to download (Ensure all are selected). 
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5. Use the ‘Browse’ button to select a suitable location to extract the contents of the FRM/SFRM 

to. 
 

Note! There must be sufficient free memory space to accommodate the entire 
downloaded data set. This may require up to 4GB of free memory space, dependant 
on the FRM/SFRM being downloaded. 

 
 

 
Figure 4-24  – Download Wizard Data Management Page 

6. Enter the password to begin the download process. The default password is ‘VDR’ (case 
sensitive). 

 
Note! Depending on the FRM/SFRM design, the download process may take 
anywhere from 15 minutes up to 4 hours. 

 

 
Figure 4-25 – Download in Progress 
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7. When the download has completed successfully, a message will appear in the log window of 
the FRM Download Application indicating the download has completed along with the 
elapsed download time and the average speed of the download. 

 

 
Figure 4-26 – Download Complete 

 
8. Once the download is complete, disconnect from the FRM/SFRM by selecting ‘Exit’ from the 

‘File’ menu. 
9. The downloaded data may now be reviewed using the Rutter Playback software. 
 

4.3 Damage to Ship and Severe Damage to FRM/SFRM 
In the event that the FRM/SFRM has undergone severe mechanical damage, fire, or if the 
memory cable is damaged or destroyed, the module will have to be returned to the 
manufacturer’s facility for repair.  Refer to Appendix C for further information.
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5 Operation and Alarm Unit—User Guide 
 
 
This section provides a user guide for operating the Operation and Alarm unit which is the user interface 
with the VDR-100G3/S. All user-level operation occurs via the OAU. The OAU provides the ability to 
secure data as well as offering audible alarms that alert the user to potential problems with the unit and/or 
component connections. 
 

5.1 OAU Display 
 
The OAU presents the following information, when in normal operational mode, at a 4 line alphanumeric 
illuminated display: 
 
(Line 1)  (This line blank unless required to display longer messages) 
(Line 2)  Status: Recording 
(Line 3)  (This line blank unless required to display longer messages) 
(Line 4)  USB: Rec 
 

5.2 OAU Keypad 
 
The VDR is operated by the illuminated keypad of the OAU and associated information presented on its 
display: 

 

 
Figure 5-1 – OAU Keypad 

 
 
Press “Enter” to execute a command 

 
 
 

Press “Cancel” to undo an initiated operation, if not otherwise instructed by the display 
menu. 
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5.3 Securing Data 
 

To secure data to the DMM, complete the following steps: 
 

1. Press the “Emerg Backup” button on the OAU keypad. The 
following message will appear on the OAU’s LCD: 

 
“Perform Emergency Backup of VDR Data” 
“<Enter to Confirm>” 
 
2. Press the “Enter” button on the OAU keypad. The 
following message will appear: 
 
“Download Complete” 
“<Enter” to Return>” 

 
Note: This process will secure the current 12 hour data set; or all data since the last time the 
Emergency Backup button was pressed if this was less than 12 hours ago. 
5.4 Muting Audible Alarm 
 

To mute the audible alarm, press the “Mute” key on the OAU 
keypad. 
 
For a list of alarm messages which appear on the OAU display, 
please see Section 3.6 Status and Alarm Messages 
The alarm message will remain on the display until the cause of 
the alarm is resolved. Make note of all alarm messages to inform 
the technical support provider. 

5.5 Dimming the Display 
To dim or brighten the LCD display press the “Dim” key on the 
OAU keypad  and toggle to any 1of the 4 brightness levels. 
 
 

 

5.6 Test Screen 
To get the VDR Record software version number or 
the unique DMM Hardware ID, press the “Test” key 
on the OAU keypad. 
 
An example of the information provided via the 
“Tests” menu, is as follows: 
 
**Test Screen** 
Version: 6.0X.00 
ID: 55N5SS5S55X21 
 
Press the “Cancel” button to return to the main 
screen. 
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5.7 Viewing Recorded Data on the DMM Internal Hard 
Drive 

 
The VDR-100G3 stores all data on the internal hard drive in 3 different locations: 
 

 Current Data: 24 hours of the most recently recorded data, stored by 2 sets of  12 hours 
each, 

 Secured Data: There may be several secured data sets in the overwrite-protected 
memory space, see 5.3., and 

 Archived Data: Up to 30 days of data, archived by up to 60 sets of 12 hours each. 
 
Note: Unlike the FRM, which may contain only the data required by IMO regulations, the internal 
storage locations typically contain a much larger and more detailed data set. This data set 
includes all AIS/NMEA, and all audio and video data channels collected by the VDR-100G3. If the 
VDR records more than the minimum data required by IMO, the timeframe recorded may be 
shorter than the times listed above. 
  
To view a list of recorded data on the OAU display by date and time (To copy selected data sets 
to a removable USB storage device, see Copying Data to a USB Memory Stick (or optional 
RSM)) 

 
Important! If you do not intend to copy data, do not press “Enter” when date/time 
indications of data sets are displayed, otherwise you will immediately initiate a copy 
process and you may overwrite data on the connected removable storage device, 
subject to its status, see below! 
 

1. Press the “Copy” button on the OAU keypad. To 
leave the “View Data” function press “Cancel”. 
 

2. To use the view data function press the “↓↑” keys to 
move the OAU cursor to “Copy Data”, “Copy 
Secured”, or “Copy Archived”, then press the 
“Enter” button on the OAU keypad. 

 
 

3. When “Copy Data” is selected the OAU LCD 
displays:  
“Copy Current Data” (the current 12 h data set), or 
“Copy All Data” (the current 2 x 12 h most recently 
recorded data). 

 
4. When “Secured Data” is selected the OAU will 

display secured data sets of 2 per page. 
a. Use the ←  → keys to navigate through the data sets by pages, or 

the  “↓↑” keys to navigate through the data sets one at a time.  
b. Data sets appear from oldest to newest and are recorded with the 

following time format: yyyy-mm-dd-hh-mm (where yyyy=year, 
mm=month, dd=day, hh=hour, and mm=minute). 

 
5. When “Archived Data” is selected the operation is 

the same as for “Secured Data” except the may be a greater number of pages from which to 
select data sets. 



 

VDR-100G2/G2S Data Recovery Manual  3/24/2008 
RUT-UM-02-003 Rev. 1.0 

40

5.8 Status and Alarm Messages 
 

Listed below are the alarm codes that may appear on the OAU display: 
 

Alarm Code Description 

System Error Communication with the Record Application has been lost 

Video Error Communication with the Video Module has been lost 

Audio Error Communication with the Audio Module has been lost 

FRM Error Communication with the Final Recording Medium has been lost 

Power Fail Loss of utility power.  

PCM Error Communication has been lost with the Power Control Module 

Remote Error Communication has been lost with the RSM or the USB Memory Stick 

Serial Error Communication has been lost with the NMEA Module 

Mic Error Communication has been lost with one of the microphones 

Disk Error Failure to write data to the DMM internal hard drive 

GPS Error Failure to record GPS data 

Table 5-1 - Alarm Code Description 

 
NOTE: Pressing the “Mute” button acknowledges the alarm code 
and silences the alarm. The alarm message will be displayed as long as 
the condition causing the alarm exists.  
 
 

 

USB Memory Stick and RSM OAU Status Messages 

 Drive Absent Drive Present, Not 
Recording 

Drive Present, 
Recording 

Drive Error 
Detected* 

USB NONE STBY REC ERR 

RSM NONE STBY Not Applicable ERR 

* When an error is detected with either the USB Memory Stick and/or the RSM, 
the OAU will also display a “REMOTE ERROR” alarm. 

Table 5-2 - USB Memory Stick and RSM OAU Status
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6 Playback Software 
 
 
The playback module accompanies the base model VDR and is resident on the download client 
PC. Additional playback software is available for use in shore-side offices. This additional 
software is necessary for the playback of data on the RSM or other media once it has been 
removed from the ship and transported to the office environment. 
 

Important! The computer on which the Playback application is being installed 
must have its regional and language options adjusted to English. This may be 
done by double clicking the ‘Regional Options’ icon in the Control Panel window and 
selecting ‘English’ from the language drop down list. It is recommended that either 
‘English (United States)’ or ‘English (Canada)’ is selected. However, any of the 
available English options are acceptable. 

 
The Playback application has two modes of operation. In Playback mode, the user can replay 
saved data sets. In Real Time Display mode, the Playback application will replay real time Audio 
and NMEA data that is received from the VDR. Audio data is not available during Real Time 
Display mode. 

6.1 Playback Installation – Client/Standalone PC 
The installation of playback software is automated and requires little interaction. The install is 
performed via a self-extracting executable file and is automatically installed to the C:\Program 
Files\Playback directory, with a shortcut placed on the Windows desktop. The install file will 
normally be named “Install VDR Playback.exe”. 
 
To begin the installation, complete the steps listed below: 

1. On the installation CD, double click the file entitled ‘Install VDR Playback.exe’. 
 

 
Figure 6-1 – Installation Executable File 

 
2. Choose the directory to which the executable will be installed. 

 

 
Figure 6-2 – Choose Installation Directory 

 
3. To abort the installation, click the ‘Abort’ button on the ‘Installing…’ message window. 
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Figure 6-3 – Installing Message Window 

 
4.  A prompt will appear asking the user to clarify creating the install directory.  Click “Yes” to 

create it.  If “No” is chosen the user will be prompted to choose an alternative directory 
 

 
Figure 6-4 - Choose Installation Directory 

 
5. Click “Yes” to reboot computer to finish the VDR Playback installation.  Clicking “No” will 

allow a reboot at a later time. 
 

 
Figure 6-5 - Reboot warning 

 
When the installation is complete, a shortcut to VDR Playback will be placed on the Windows 
desktop. 
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6.2 Starting the Playback Application 
To start the playback application, double click the playback icon located on the desktop (as 
mentioned in step 4 of the installation process above). The application will look similar to Figure 
6-6 – Playback Software shown below.   
 
Note that the playback application interprets information provided in the ship’s VDRPlayback.ini 
file therefore the playback interface may contain elements and controls different from what is 
shown below. 
 

 
Figure 6-6 – Playback Software 

6.2.1 Configuration File 
The vessel displayed in the Playback application is automatically configured via the ship’s 
configuration file, which is created by the installation technician during the installation of the VDR. 
The configuration file pertaining to the ship whose data will be used by the Playback application 
must be located in an easily accessed location on the local hard drive of the playback PC. 
 
Upon start-up of the Playback application, the configuration file can be loaded using the File > 
Configure menu item. 

 
Figure 6-7 – Configuration File Selection – Menu Item 



Chapter 6: Playback Software 
 

VDR-100G2/G2S Data Recovery Manual  3/24/2008 
RUT-UM-02-003 Rev. 1.0 

44

 
 
A dialog window will appear allowing the user to select the applicable file. Once the file has been 
selected the Playback application will shut down momentarily and restart automatically. Upon 
restart the chosen configuration file will load automatically. To change the configuration file, select 
the File > Configure menu item, as above, and choose the newly desired file. 
 

 
Figure 6-8 – Restart Warning 

 
With the VDR-100G3, the ship’s configuration file will accompany every available data set. When 
a data set is selected the configuration file will be automatically reloaded as necessary. 

6.3 Choosing Data for Playback 
To select a data set for playback: 

1. From the “File “ menu choose “Select Data Set”. A dialog box will appear A dialog box 
will appear. 

2. Locate the folder containing the downloaded data.  The Playback application will 
automatically search for and select the “AudioDir.vdr” index file as seen in Figure 6.9 
below. Click “Open” to proceed. 

 

 
Figure 6-9 - Locating Downloaded Data 

 
3. The .vdr files accompany every download and act as an “index” to the actual data files. 

They are named according to the data items they reference: AudioDir.vdr for audio, 
NMEADir.vdr for NMEA data and VideoDir.vdr for video data. Select “All Files” from the 
“Files of Type” drop down box to view all .vdr index files.  Selecting any one of these 
three files will open a data set for playback. 

 
 

Note! If the download directory does not display three (3) files with extensions of 
“.vdr”, it is possible that the Microsoft operating system is treating them as hidden 
files.  
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To ensure that the .vdr files are being displayed (and not hidden by the operating system), follow 
these steps: 
 

1. Open Windows Explorer 
2. Select ‘Folder Options’ from the ‘Tools’ menu 
3. Select the ‘View’ tab 
4. Ensure that ‘Show Hidden Files and Folders’ is selected 
5. Press the ‘OK’ button. 

 

 
Figure 6-10 - Choose a .vdr File 

If Playback cannot locate the vdr-cfg.txt file a prompt will appear as seen below.  If the 
configuration file has already been pre-selected using “Configure” from the “File “ menu then click 
“Cancel”.  Otherwise, click “OK” to select the configuration file contained on the local hard drive or 
other media. 

 
Figure 6-11 - Configuration file not found 

6.3.1 Unarchive Extracted Data 
Data for playback can also be chosen from a previously extracted data archive.  If a portion of 
data has been previously extracted and archived it can be opened for playback via the  
File > Unarchive Extracted Data file menu option. 
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Figure 6-12 – Unarchive Extracted Data 

 
To playback the archived data after selecting the “Unarchive Extracted Data” file menu option, a 
user will have to locate the .rfa (archive) file and select a folder to which the data can be 
extracted.  Once extracted, an applicable configuration file will need to be selected in order to 
continue playback. 
 

6.4 Enabling Ethernet Broadcasts 
To enable the Playback software and Client PC to broadcast data across a network for use with a 
separate Electronic Charting System (ECS) or software, open the ‘Output’ menu dropdown and 
select “Enable Ethernet Broadcast”. If a check appears adjacent to this option, broadcasting is 
currently enabled. To disable this option, ensure no check sign appears adjacent to it. 
 

 
Figure 6-13 – Enabling Ethernet Broadcasting 

 
The broadcast will occur on UDP Port 4450 and 4451. Refer to the relevant ECS manual to 
properly enable a PC to receive an Ethernet broadcast from Rutter Technologies’ Playback 
software. 
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6.5 Starting the Playback 
To start the data playback, complete the following steps: 
 

1. Ensure that the Real Time Display mode of the Playback Application is disabled. Open 
the ‘Mode’ menu dropdown. If a check appears adjacent to the “Real Time Display” 
option, Real Time Display mode is currently enabled. To disable this option, ensure no 
check sign appears adjacent to it. 

 
2. After a set of download data has been selected for playback, choose ‘Start’ from the 

‘Playback’ menu or press the ‘Play’ button located on the ‘Controls’ toolbar 
 
 
 

 
Figure 6-14 – Controls Toolbar 

 
 

3. A dialog box will appear asking for a password. The default password is “VDR”. The 
password is case sensitive. It must be typed in the text box and the ‘OK’ button clicked 

4. After entering the correct password and clicking the ‘OK’ button, a second dialog box will 
appear, asking for a start time. Use the scroll bar (or enter a time in the text boxes) to 
select a playback start time. Click ‘OK’ to begin the playback. 

 

 
Figure 6-15 – Choose Start Time For Playback 

 
 

6.6 Configuring the Client to Receive Real Time Data 
Configure the Client PC for the ‘Playback Application’ to connect to the VDR-100G3 and receive 
the recorded data. To do this, the Client PC must be in the same IP segment as the download 
port on the VDR. The VDR’s download port occupies IP address 200.200.200.200. The client PC 
must be in the same range, with the last segment different than the VDR (as shown below.) To 
change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 

Stop 
Play Pause Fast Forward 

Open 

Fast Forward Rate 

Start Time Scrollbar 

Playback Data Rewind Time 
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c) Right-click on the Local Area Connection icon, and select Properties from the pop-up 
menu. 

d) In the Local Area Connection Properties window, highlight “Internet Protocol 
(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use the 
following IP address” radio button and enter 200.200.200.2 (the last number can be 
any number from 2 to 254, except 200.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local Area 
Connection Properties.  

 
Figure 6-16 - Establishing TCP/IP Address 

6.7 Enabling Real Time Display Mode 
The Playback application has two modes of operation. In playback mode, the user can replay 
saved data sets. In Real Time Display mode, the Playback application will replay real time Audio 
and NMEA data received from the VDR. Audio data is not available during Real Time Display 
Mode. 
 

Note! Prior to enabling Real Time Display on the Playback application, the Client 
PC must be connected to the VDR’s download port (or the Ethernet switch that 
may be attached to the VDR’s download port) via Ethernet. See 6.6 Configuring 
the Client to Receive Real Time Data for details. 

 
To activate the Real Time Display mode of the Playback Application, open the ‘Mode’ menu 
dropdown and select “Real Time Display”. If a check appears adjacent to this option, Real Time 
Display mode is currently enabled. To disable this option, ensure no check sign appears adjacent 
to it. 
 

 
Figure 6-17 - Enabling Real Time Display Mode 
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When Real Time Display mode is entered, a pop-up window will appear indicating that Real Time 
Display has been enabled. 
 

 
Figure 6-18 - Real Time Display Mode Confirmation 

 
Many of the normal Playback mode options are disabled when operating in Real Time Display 
mode, as they are not applicable. All disabled options will be greyed, such that they are still 
visible but not available for selection. 

6.8 Starting the Playback in Real Time Display Mode 
To start the playback of real time data, complete the following steps: 
 

1. Follow instructions in Section 6.2.1: Configuration File to select a valid configuration file. 
2. Choose ‘Start’ from the ‘Playback’ menu or press the ‘Play’ button located on the 

‘Controls’ toolbar 
 
 

 
Figure 6-19 - Controls Toolbar 

 

 
3. A dialog box will appear asking for a password. The default password is “VDR”. The 

password is case sensitive. It must be typed in the text box and the ‘OK’ button clicked 
4. After entering the correct password and clicking the ‘OK’ button Real Time Display 

playback will begin. 

6.9 Passwords 
There are 2  passwords required to run the playback software. 
 
The first is necessary to run the playback. It is supplied with the software and can be changed by 
choosing ‘Set Password’ from the ‘Playback’ file menu. A dialog box will appear asking for the old 
and new passwords. 
 
The second password is for playback of audio data. It can be changed by choosing ‘Set 
Password’ from the ‘Audio’ file menu. All default passwords are “VDR” (case sensitive). 
 
 
 
 

Play 
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Figure 6-20 – Change Password 

 
 

6.10 Playback Controls 
The playback can be controlled via ‘Playback’ menu items or by using the buttons located on the 
Controls toolbar. Both options offer a full range of controls, including the ability to run the 
playback in fast time (with the additional option of choosing replay speed). Figure 6-14 – Controls 
Toolbar provides an illustration of the toolbar. If available for use, buttons will appear blue (such 
as the ‘Play’ button in the illustration). If unavailable for use, buttons will be greyed (such as the 
‘Pause’ button in the illustration). 
 
While playback is stopped, the ‘Fast Forward Rate’ drop down box can be used to set the 
playback fast forward speed. 
 
 

NOTE! The ‘Fast Forward Rate’ drop down box cannot be manipulated once a 
playback has started. 

 
 

NOTE! Many of the controls available during Playback mode are not applicable 
during Real Time Display mode therefore they are disabled (greyed). 

 
 
To activate the fast forward feature, press the ‘Fast Forward’ button. Return the playback to 
normal time by pressing the fast forward button a second time. 
 
Select ‘Set Playback Rate’ (Playback > Set Playback Rate) to adjust the speed of the replay 
using the ‘Playback’ menu.  A dialog box will appear requiring a time compression rate. Enter any 
integer from 2 to 24 (inclusive) in the open text box and press ‘OK’ (see Figure 6-21 – Set Fast 
Forward Rate). 
 
 

 
Figure 6-21 – Set Fast Forward Rate 
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The playback can be halted with the same time index in place by pressing the pause button. 
Press the pause button a second time to continue the playback. 
 
The Controls toolbar can also be hidden by deselecting ‘Controls’ from the ‘View’ menu. By 
default it is visible therefore a check will appear adjacent to this option. Deselecting it will remove 
this check mark. 
 

6.11 Audio Volume & Channel Selection 
Audio data includes continuous bridge audio and radio communications. The configuration of 
audio will differ between ships but is generally arranged in 2 to 4 banks. 
 
Individual channels contain audio data corresponding to an area of the bridge, bridge wings, or 
radio communications. Each channel may be included in the playback individually or in 
conjunction with other channels. For example, a user may wish to play back audio data recorded 
in the centre of the bridge while turning off external microphones where wind noise may be 
present. 
 

 
Figure 6-22 – Audio Interface 

 
 
To activate the audio portion of a playback, choose ‘Unlock Audio’ from the ‘Audio’ file menu (see 
Figure 6-23 – Audio Menu).  A prompt will appear requiring a password; the default password 
supplied with the VDR-100G3 is “VDR”.  Press ‘OK’ to activate the audio data and make each 
channel in the ‘Audio’ file menu selectable.   
 
Once unlocked, audio data will be available for the remainder of the time playback is open.  Audio 
can be adjusted by opening the “Audio Volume” window (see Figure 6-22 – Audio Interface) via 
the “Audio Volume” option in the Audio file menu. 
 



Chapter 6: Playback Software 
 

VDR-100G2/G2S Data Recovery Manual  3/24/2008 
RUT-UM-02-003 Rev. 1.0 

52

 
Figure 6-23 – Audio Menu 

 
 
There are two (2) ways to activate an available audio channel individually: 
 

 Select the appropriate audio channel from the ‘Audio’ file menu, or, 
 Click the ‘Active’ checkbox below the appropriate channel once the audio has been 

unlocked. 
 It is also possible to print the audio status to the ‘Log’ Tab Screen by selecting 

‘Status’ from the ‘Audio’ file menu. 
 
To silence a playback, simply uncheck each channel either on the ‘Audio’ menu or via the ‘Active’ 
checkbox. 
 
 
 

Note! Audio data is not available during Real Time Display mode, thus all Audio 
options are disabled, including all audio options under the ‘Audio’ file menu. 

 
 

6.12 Conning Page Tab 
The Conning Data Tab is the default screen upon Playback start-up. In addition to the Propulsion 
and Video Channel(s) (for example, PORT X-Band, STBD S-Band, and CCTV) information tab(s) 
found in the centre of the screen, the Conning Data Tab also contains the following information 
(all along the upper left hand side of the tab screen): 
 
 

 Date – Date of playback information 
 Time – Time of playback information 
 Latitude – Ship’s latitude 
 Longitude – Ship’s longitude 
 GPS Mode – Global Positioning System: SPS, DGPS (Differential GPS), PPS, RTK (Real 

Time Kinematic), FRTK (Float Real Time Kinematic), and DRM (Dead Reckoning Mode) 
 Heading – Ship’s heading 
 Autopilot – Indicates the presence or non-presence of a heading control system (On/Off) 
 COG – Ship’s Course Over Ground 
 SOG – Ship’s Speed Over Ground 
 Depth – Depth of ship 
 ROT – Ship’s Rate Of Turn 
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6.12.1 Depth Graph 
The Depth Graph provides an illustration, in metres (m), of the ship’s depth. 
 

 
Figure 6-24 – Depth Graph 

 

6.12.2 Wind Information 
The Wind Information pane contains data regarding the wind’s True and Relative Direction (Dir) 
and Speed (Sp).  
 
A compass is also provided in order to illustrate wind direction based on ship’s heading. The red 
arrow indicates True wind direction while the green arrow indicates Relative wind direction. The 
ship graphic indicates the ship’s heading. 
 

 
Figure 6-25 – Wind Information 

 

Red Arrow – True Wind Direction 

Ship Graphic – Ship Heading 
Green Arrow – Relative Wind Direction 
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6.13 Propulsion Tab 
The Propulsion Data Tab is custom designed for each individual ship according to propulsion 
systems, bow thruster configuration and NMEA strings broadcast by bridge electronics. These 
displays are dependant upon the VDRPlayback.ini file created for a particular ship. 
 

 
Figure 6-26 – Sample Propulsion Tab 

 
 
 

6.14 Video Channel Display Tab(s)  
Radar data is captured at 15-second intervals. If multiple radar images are available for video 
capture, capture times will be staggered but still allow for individual captures at 15-second 
intervals. 
 
There are a number of options available when viewing the radar data: 

 To display the radar data in its own window, choose View > Full Size Video > Video 
Channel. To close this window, click the ‘x’ in the top right corner. 

 To move the radar image (once in its own window) in order to make a particular 
section visible without adjusting the window dimensions, click and drag by placing the 
mouse pointer over a section of the image, pressing the left mouse button and 
moving the mouse; 

 To view the whole radar image available in its own window select View > Fit to 
Window > Video Channel; 

 To save the radar image as a .bmp file, select the ‘File’ menu > Save > Video 
Channels. A dialogue will open allowing a save location to be chosen. 
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Figure 6-27 – MultiPilot Tab 

 
 
The images are captured directly from the radar display; therefore any radar supporting ECDIS or 
chart displays will have the ECDIS or chart image recorded. 
 

Note! If proprietary data is present in the data playback, a “Proprietary” conning tab 
may appear. This tab window will present the available proprietary data in sentence 
format. 

 

6.15 Proprietary Tab 
 
If proprietary data is present in the data playback, a “Proprietary” conning tab may appear. This 
tab window will present the available proprietary data in sentence format. 
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6.16 AIS Playback Tab 
The ‘AIS Playback’ Tab Screen displays information captured from the ship’s AIS. 
 

 
Figure 6-28 – AIS Playback Tab 

 
There are a number of features available within the AIS Playback tab screen that allow a user to 
better interpret the downloaded information. 
 

6.16.1 Targets 
The Targets section of the AIS Playback tab screen provides a range of information about all 
targets visible in the playback window. 
 

 Targets Tab – provides a list of all ships available within the AIS view screen.  If a 
ship’s information becomes unavailable it remains in the list but a line is drawn through 
its name (it is also added to the “Lost” tab list (see below)). 

 Activated Tab – provides the name of the ship selected by the user in the AIS view 
screen. 

 Lost Tab – provides a list of ships for which information is no longer available. 
 Dangerous Tab – provides a list of all ships that are currently on a dangerous course 

relative to ownship.  
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Figure 6-29 – Targets Information Section 

Specific ship information is also available in the following tabs (located below the above 
mentioned tabs): 
 

 Collision Info – provides information specific to a selected ship’s navigational course. 
 Target Info – provides registered information (e.g., MMSI, IMO, etc.) specific to a 

selected ship. 
 Own Ship – provides registered and navigational information for ownship regardless of 

what target is selected. 

6.16.2 View Settings 
The View Settings section allows a user a high level of control over the AIS playback view screen. 
 

 
Figure 6-30 – View Settings Section 

 Viewing Range – It is possible to increase or decrease the viewing range of the AIS 
playback view screen by pressing the “+” and “-“ buttons located in the upper right of the 
View Settings section.  Note that if using a wheel mouse the viewing range can also be 
increased/decreased by moving the wheel while the pointer is located in the view 
screen.  The viewing range is listed in nautical miles. 

 Location – The latitude and longitude of the selected target is listed. 
 Center on Selected Target – If this checkbox is selected the view screen will center on 

the selected target. 
 Set Center Button – To set the center point of the view screen, press the “Set Center” 

button, position the mouse pointer on a location on the view screen and left-click.  This 
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point will now be the center point of the view screen.  Turning on the “Center on 
Selected Target” checkbox overrides this control. 

 Full Screen – Opens a dedicated AIS Playback window. 

6.16.2.1 AIS Display Settings 
The “Settings” button located in the View Settings section opens an “AIS Display Settings” 
window.  The settings in this window allow the user to adjust the AIS Playback display. 
 

 
Figure 6-31 – AIS Display Settings Window 

 CPA (Closest Point of Approach) 
 TCPA (Time to Closest Point of Approach) 
 COG (Course Over Ground) 
 LOA (Length Over All) 

6.16.3 GuardZone 
The GuardZone section allows a user to create a guard zone in the view screen.  To create a 
guard zone press the “Create” button, place the mouse cursor in the view screen area and left-
click in the locations required to create a guard zone shape.  Double-click to complete the guard 
zone formation. 
 
The guard zone can be enabled or disabled by checking or unchecking the “Enabled” checkbox. 
 
 

 
Figure 6-32 - GuardZone enable/disable 
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6.17 Log Tab 
The ‘Log’ Tab Screen displays the size of each type of data block and the time it was recorded. 
When viewed in compressed time (fast forward), the size of data blocks written at each time-
period is displayed, but the actual NMEA strings are not. When played back in normal time, the 
‘Log’ Tab Screen will also display the NMEA strings. 
 
‘Log’ information can be controlled via the Controls toolbar. To scroll illustrated information, press 
the ‘Pause’ button on the Controls toolbar and use the ‘Log’ scrollbar to navigate. 
 

 
Figure 6-33 - Log Window 
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6.17.1 Error Codes 
The following table provides a list of error codes and descriptions that may be observed in the 
Log Window of the Playback application: 
 
Error Code Alarm Message Binary Bit Position 

99$0 Status Clear 0000000000 

99$1 Storage Error 0000000001 

99$2 Video Error 0000000010 

99$4 Audio Error 0000000100 

99$8 NMEA Error 0000001000 

99$16 Power Error 0000010000 

99$32 Microphone Error 0000100000 

99$64 FRM Error 0001000000 

99$128 Lyngso Error 0010000000 

99$256 Power Comms Error 0100000000 

99$512 Remote Error 1000000000 

99$1024 GPS Error 10000000000 

Table 6-1 - Error Code - Playback Log Window 

In the event of simultaneous errors, it will be necessary to convert the displayed error code to its 
binary counterpart. A multiple error will display multiple 1-bits in the binary string, which can then 
be interpreted. For example, the error code 99$17 converts to a binary string of 0000010001, 
representing a simultaneous Storage and Power error. 
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6.18 Fire Doors Tab  
The Fire Doors Tab Screen displays information regarding the status of the ship’s fire doors. The 
colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening. 
 
Should the number of fire doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 6-34 – Fire Doors Tab 
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6.19 Water Doors Tab  
The Water Doors Tab Screen displays information regarding the status of the ship’s water doors. 
The colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening. 
 
Should the number of water doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 6-35 – Water Doors Tab 
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6.20 Hull Openings Tab  
The Hull Openings Tab Screen displays information regarding the status of the ship’s hull 
openings. The colour of the light adjacent to the door name, dependant upon the configuration, 
indicates an active (often indicated with the colour red) or non-active (often indicated with the 
colour green) door or opening. 
 
Should the number of hull openings exceed the initial screen space, a scroll bar will become 
visible allowing a user to view all available. 
 

 
Figure 6-36 – Hull Openings Tab 

6.21 Alarms Tab  
An alarm is an “on” event, only displaying when triggered. When an alarm occurs, the word 
“ALARM” will display in the lower left corner of the Playback interface. The Alarms tab allows a 
user to view information pertaining to all triggered alarms. 
 

6.22 Data Extraction 
The volume of data contained in downloaded VDR data sets can be very large.  In many 
instances it may be desirable to access smaller portions of the data without downloading the 
entire data set.  As a result it is possible to copy only a specific portion of a data set, which can 
then be easily removed to a separate location for analysis or e-mailed to a third party. 
 
 

Note! The Data Extraction option is not available during Real Time Display mode. 
The ‘Data Extraction’ option under the ‘Data’ file menu is disabled while the 
Playback application is operating in Real Time Display mode. 

 
 

6.22.1 Open Extraction Window 
To extract a specific portion of data, begin the playback of captured data.   Once data is in active 
playback mode allow it to play until the beginning point of the portion desired for extraction is 
reached: 
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1. Select “Data Extraction” option from the “Data” file menu. 

 

 
Figure 6-37 – Data Extraction Option 

 
 

2. The Data Extraction window will open (see Figure 6-38 – Data Extraction Window below).  
This may take a number of seconds.  The start time will automatically appear as the point 
in the playback where the Data Extraction window was opened. 

 

 
Figure 6-38 – Data Extraction Window 

 
 

6.22.2 Selecting Data for Extraction 
With the Data Extraction window open it is now necessary to select a segment of data to extract 
and an extraction destination. 
 

1. Three data stream options (Video, Audio, and NMEA) are available for download.  Check 
the adjacent checkbox to select the desired data stream.  If no data stream is selected 
the Start and Stop scroll bars will not be available. 

2. When the “Video” checkbox is selected additional options will appear (may take a number 
of seconds).  The user will have the option to download individual Video channels as 
required (if available).  There is also an option to select 1 to 4 video image(s) per minute; 
selecting “1” allows a user to reduce the size of the Video data extraction (1 image 
capture per minute). 
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Figure 6-39 – Data Stream Options w/ Video Selected 

 
3. Select a destination directory by clicking the word “Destination” (or, alternately, choosing 

“Choose Destination Dir” from the “Data” file menu).   
 
Note: the destination directory cannot be the same as the source directory 
and cannot contain any other files. 

 
4. Select a Start and Stop time for the extracted segment.  As mentioned above, the Start 

time automatically appears as the time when the Data Extraction window was opened.  
However, this can be changed.  To adjust either the Start or Stop time, move the 
applicable scroll bar.  The file size of the extracted segment will appear to the right of the 
Stop scroll bar.  This is useful, for example, when attempting to extract a segment to copy 
to a recordable Compact Disc. 

5. To create an archived file of the extracted data at the same time as the extracted data is 
being copied to the selected destination folder, select the “Archive Extracted Data” 
checkbox. 

6. To start the data extraction, press the “Start” button located in the lower right of the Data 
Extraction window or choose the “Extract” option in the “Data” file menu (Data > Extract). 

7. A progress bar will appear at the bottom of the window to indicate the progress of the 
extraction. 

8. Once completed, the Data Extraction window can be closed via the “Exit” option in the 
“File” menu (File > Exit). 

 

6.23 Closing the Playback Application 
The application cannot be closed while a voyage playback is running. To close the application 
follow these instructions:: 
 

1. Stop the playback by selecting ‘Stop’ from the ‘Playback’ menu, or by pressing the ‘Stop’ 
button in the Controls toolbar. 

2. Press the ‘Close’ (x) button in the upper right hand corner of the application’s main 
window, or choose ‘Exit’ from the ‘File’ menu. 

 
When the Playback Application is restarted, it will restart in the mode in which it was operating 
when closed. For example, if the Playback Application was in Real Time Display mode when it 
was closed, on the next restart it will open in Real Time Display mode. 
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Appendix A – Incident Data Recovery Checklist 
 
This checklist is provided as a guideline of steps to be carried out by the incident investigation 
team in the process of recovering a FRM unit. This checklist is meant only as a guideline and 
may not represent all of the steps necessary in an incident investigation. 
 
Checklist: 
 

   Recover FRM/SFRM from incident site. 
 

   Inspect the unit for damage. 
 

   Contact the OEM with details of the damage incurred by the unit. Contact information is 
provided in Appendix C – Contact Information. 

 
   Contact the Rutter Technologies Inc. and provide all available information about the 

vessel and FRM/SFRM unit in question in order to receive the necessary files for data 
download, playback, and interpretation (contact information is provided in Appendix C – 
Contact Information). 

 
   Download data from the FRM/SFRM using methods outlined in this document. 

 
 Playback data using methods outlined in this document. 
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Appendix B – Software Download (FTP) 
 
Rutter Technologies may require, from time-to-time, approved technicians to download updated 
software via a Rutter FTP site.  Access to this site will require a Rutter Technologies provided 
password. 
 
The following instructions are provided as a step-by-step procedure for downloading software via 
this FTP site: 
 

1. Open an Internet browser, enter the following address: ftp://www.ruttertech.com in 
the “Address” field, and press “Enter”. 

2. When prompted, enter a Rutter Technologies provided User Name and Password 
combination.  Note that both User Name and Password are case sensitive. 

3. To download, right-click the applicable file and select “Copy” from the pop-up list. 
4. Select a location on the PC’s local hard drive where the file should be downloaded, 

right-click in this space, and select “Paste” from the pop-up list. 

ftp://www.ruttertech.com/�
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Appendix C – Contact Information 
 

IMPORTANT – READ THIS FIRST! 
 
Depending upon the severity and other extenuating circumstances of an incident, some 
investigative teams may opt to hand deliver the Final Recording Medium (FRM) or Simplified 
Final Recording Medium (SFRM) directly to the Original Equipment Manufacturer (OEM) 
personally. Please contact the OEM directly at the address and contact numbers listed on the 
following page to make this arrangement. 
 
Shipping labels are provided for the FRM/SFRM manufacturer that Rutter Technologies 
Incorporated currently uses and supports with the Voyage Data Recorder VDR-100G3. A 
member of the investigating team should first determine whether the FRM/SFRM is damaged in 
such a way that the normal procedure for data download or retrieval is not an option, causing the 
unit to need repair and/or refurbishment before data can be successfully downloaded or retrieved. 
 
The provided shipping labels should be used if the investigative team determines that the 
FRM/SFRM is damaged and should be sent back to the OEM. 
 
 
NOTE TO INVESTIGATORS! BE SURE TO INCLUDE A RETURN ADDRESS OR SHIPPING 
LABEL FOR THE RETURN OF FRM. 
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Contact Information for L-3 Communications Aviation 
Recorders: 
 
If unit is to be shipped back to L-3, please contact L-3 directly and obtain Return Merchandise 
Authorization (RMA). Clearly print this RMA on the shipping label in space provided and route 
shipment through L-3’s Customs Agent in Tampa, Florida, USA. 
 
L-3 Communications Custom Agents: 
Tampa International Airport 
Air Cargo Building 
4700 North Hoover Blvd. 
Tampa, Florida 33634 USA 
Telephone: (813) 273 0975 
Facsimile: (813) 875 5809  
 
L-3 Shipping Address: 
L-3 Communications 
Attn: Repair Department 
6000 East Fruitville Road 
Sarasota, Florida 34232 USA 
Telephone: (941) 371 0811 
Facsimile: (941) 377 5591 
Web: http://www.l-3ar.com/ 
 
 
Contact Information for Jotron Electronics: 
 
If unit is to be shipped back to Jotron, please contact Jotron directly and obtain Return 
Merchandise Authorization (RMA). Clearly print this RMA on the shipping label in space provided. 
 
Jotron Electronics s.a. 
P.O. Box 54 
NO-3280 Tjodalyng, Norway 
Telephone: +47 33 13 97 00 
Facsimile: +47 33 12 67 80 
Web: http://www.jotron.com 
 
 
 
Contact Information for Rutter Technologies Inc.: 

 
Rutter Technologies Inc. 
70 Brookfield Road 
St. John’s, Newfoundland 
Canada A1E 3T9 
 
Telephone: +1 709 368 4213 (available on a 24-hour basis) 
Facsimile: +1 709 368 1337 
 
Web: http://www.ruttertech.com 



Appendix C—Contact Information 
 

VDR-100G2/G2S Data Recovery Manual  3/24/2008 
RUT-UM-02-003 Rev. 1.0 

- 73 -

L-3 Communications Shipping Labels: 
 
Included on the following two pages. 
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SHIP TO: 
 

L-3 Communications 
Attention: Repair Department 
6000 East Fruitville Road, 

Sarasota, Florida 34232 USA 
 

Telephone: (941) 371 0811 
 

 

RMA# _________________________ 
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Attention: Repair Department 
6000 East Fruitville Road, 

Sarasota, Florida 34232 USA 
 

Telephone: (941) 371 0811 
 

 

RMA# _________________________ 
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RMA# _________________________
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Appendix D – IMO Guideline Document 
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4 ALBERT EMBANKMENT 
LONDON SE1 7SR 
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Ref. T2-HES/4.2 MSC.1/Circ.1253 
 26 October 2007 

 
 

SHIPBOARD TECHNICAL OPERATING AND MAINTENANCE MANUALS 
 
 

1 The Maritime Safety Committee, at its eighty-third session (3-12 October 2007), 
considered the recommendation that the attention of all relevant stakeholders needs to be drawn 
to the importance of ships� crews having access to up-to-date, accurate and user-friendly 
shipboard technical operating and maintenance manuals, particularly for safety-critical marine 
equipment. 
 
2 The Committee noted that there exists a global and competitive marketplace for marine 
equipment and that seafarers were expected to assimilate different equipment fitted on board 
quickly and operate them efficiently.  Also, seafarers were expected to be able to move from ship 
to ship with few restrictions; this flexibility being essential for the efficient management of 
human resources.  Consequently, seafarers are likely to encounter a wide variety of equipment 
fitted on board. 
 
3 The Committee also noted that the availability on board ships of up-to-date and accurate 
operating and maintenance manuals could be enforced via the implementation and enforcement 
mechanisms of the International Safety Management (ISM) Code. 
 
4 The Committee further noted IACS Recommendation No.71 (dated September 2000) 
Guide for the development of shipboard technical manuals and agreed that this Guide provided a 
useful reference for those responsible for developing such manuals. 
 
5 In light of the foregoing, Member Governments are invited to: 
 

.1 recognize the necessity for up-to-date, accurate and user-friendly shipboard 
technical operating and maintenance manuals to be available on board ships; 

 
.2 recommend that IACS Recommendation No.71 is used as a model for shipboard 

technical operating and maintenance manuals; 
 
.3 recommend that shipboard technical operating and maintenance manuals should 

be provided in the working language of the ship and if the working language is not 
English, French or Spanish, a translation into English, or French, or Spanish 
should be provided; and 

 



 - 2 - MSC.1/Circ.1253 
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.4 encourage ship designers and shipbuilders to provide diagrams and drawings 
explaining the operation of integrated ship systems as well as emergency 
operation of such ship systems, recognizing that ship systems may be composed 
of several individual pieces of equipment, 

 
and bring the above to the attention of shipowners, ship masters, shipbuilders, recognized 
organizations and, in particular, manufacturers of equipment for safety-critical marine 
equipment. 
 
 

___________ 
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